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Abstract 

 

Hydrologic and water quality modeling with the Hydrological Simulation Program-Fortran (HSPF) 
involves managing large volumes of data.  Among that data are parameters describing watershed 
characteristics, which often are derived from Geographic Information Systems (GIS) layers such as 
subbasin boundaries and land uses.  Other parameters specify simulation options within HSPF.  All of 
these parameters are input to HSPF by means of a text file, known as the User Control Input (UCI) file, 
containing a series of tightly formatted records.  The values on the records must be formatted precisely, 
and the records must themselves be arranged in a preordained order for HSPF to understand. 

WinHSPF was designed as an interactive Windows interface to HSPF.   WinHSPF assists the user in 
building UCI files from GIS data, especially data from the US Environmental Protection Agency’s 
BASINS system.  After the UCI file is built, WinHSPF is used to view, understand, and modify the model 
representation of a watershed.  The Fortran program HSPF can be run from within WinHSPF.  A given 
UCI file can be modified and saved by another name, thus creating model simulation scenarios.  Within 
the BASINS system, WinHSPF is intended to be used in conjunction with the interactive program known 
as ‘GENeration and analysis of model simulation SCeNarios’, or GenScn.  GenScn allows the user to 
analyze results of model simulation scenarios and compare scenarios.   
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Introduction 

Purpose of Report 
 

This manual assists both end users and system administrators with the interactive computer program 
WinHSPF.  Following the introduction is a chapter entitled User’s Guide.  This chapter contains four 
sections.  The first section is entitled User Interface. It provides guidance for navigating the graphical user 
interface.  The next section includes an Overview of WinHSPF from a systems perspective.  Included is 
information relating to the system hardware and software requirements, system architecture, and sample 
data provided.  Following that section is a series of Tutorials designed to familiarize a user with getting 
around within WinHSPF.  The last section of the User’s Guide, Detailed Functions, provides more 
specifics about individual functions of modules of WinHSPF.  This manual concludes with a list of 
references and an appendix containing descriptions of the four types of BASINS files used by WinHSPF. 

 

Background 

 
Use of the Hydrological Simulation Program-Fortran (HSPF) watershed model (Bicknell and others, 
1997) traditionally involved using a text editor to build an input sequence to describe a watershed’s 
physical and water management characteristics. For large, complex river basins, input sequences were 
often thousands of lines long when water quality was simulated in addition to the hydrology. The 
processes of building a new input sequence and making changes to an existing one were time consuming 
and complex. In addition, the physical abstraction of a watershed was not at all apparent from looking at 
the input sequence.  It was difficult for a user to understand how the model representation of a watershed 
related to the watershed in the real world. 

The development of WinHSPF came as a response to the need to make HSPF input sequences easier to 
build and modify. WinHSPF provides advanced interaction with the HSPF input sequence and graphical 
illustration of the model representation.  WinHSPF was created for the US Environmental Protection 
Agency’s BASINS system, although any HSPF user would benefit from its advanced input sequence 
modification functionality. 

Capabilities and Uses 
 

WinHSPF provides an interactive interface to HSPF in a Windows environment.  WinHSPF may be used 
for creating a new HSPF input sequence or for modifying an existing HSPF input sequence.  The program 
HSPF may be run from within WinHSPF.  Input Sequences may be modified and saved under another 
name, thus creating simulation scenarios.  WinHSPF also assists the user in building the necessary data 
sets and making the necessary modifications to the input sequence for hydrologic calibration using the 
United States Geological Survey’s Expert System for the Calibration of HSPF (HSPEXP). 
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User’s Guide 
 

This user’s guide provides: 

• a description of how to use the forms and menus of the user interface; 

• an overview of the system architecture, and sample data; 

• a tutorial containing a set of lessons that shows the major features of WinHSPF; and 

• a detailed description of the forms and menus for each major function in WinHSPF in (detailed 
functions). 
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User Interface 
 

The majority of the user interface consists of standard Windows (95/98/NT/2000) components.  All forms 
within the system are made up of varying numbers of menus, toolbars, buttons, lists, check boxes, radio 
buttons, command buttons, picture boxes, and text boxes.  All mouse interaction is through the left mouse 
button.  More detailed information on the objects that make up the forms may be found in the Windows 
on-line help.   A few extensions to the Windows interface are used in WinHSPF, but these operate in a 
similar manner to Windows components. 

Graphical User Interface Conventions 
 

WinHSPF was developed for user interaction to take place through a graphical user interface (GUI). 
Screens are organized in a logical manner to minimize both user learning time and user mouse/keystroke 
effort.  Information within WinHSPF is often organized in layers, with the most basic, important 
information being readily available and more detailed, less frequently used information being accessed 
through additional menus or buttons.  Another way that information may be layered is through the use of 
overlaid tabs, with the most frequently used tabs on top of the stack. 

WinHSPF was also designed to assist the user in keeping track of where they are in the system.  This was 
done by labeling all of the sub forms with titles that indicate the task being performed.  This labeling also 
confirms to the user that they got to the right place in the system after selecting a menu option or button.  
The label on the main form is updated to include the name of the project being run every time a project is 
opened. 

Keyboard Shortcuts 
 

To allow users the flexibility of not using a mouse, keyboard shortcuts have been provided to perform all 
of the functions throughout WinHSPF.  Some controls, such as menus and buttons, may be activated by 
holding down the Alt key and then pressing the letter underlined in the control.  Other controls may only 
be manipulated using keyboard shortcuts if the control has the “focus.”  Focus means that the control can 
receive keyboard or mouse input.  Focus is indicated by a dashed line surrounding the control.  When 
using the keyboard, the focus is changed from one control to the next by using the Tab key (a mouse sets 
the focus to the control on which it has clicked). 

Menu titles may be activated by holding down the Alt key and then pressing the letter underlined in the 
desired menu title.  Once a menu title has been activated (that is, pulled down), the desired menu item 
may be selected by pressing the underlined letter or by highlighting the item using the arrow keys and 
then pressing the Enter key.  For example, to select the File:Open menu item, one would type ALT-FO. 

Buttons may be activated in one of two ways.  If a button caption has an underlined letter, holding down 
the Alt key and pressing the underlined letter will activate the button.  A button may also be activated by 
setting the focus to the button and then pressing the Enter key. 
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In this picture, the OK button has a keyboard shortcut, indicated by the underline, so pressing Alt-O will 
activate the OK button as if it had been clicked with the mouse. The dashed line around the Cancel 
button indicates that button currently has focus, so pressing Enter will activate the Cancel button as if it 
had been clicked with the mouse. A button labeled Cancel can also be activated by pressing the Esc key. 

Selection of list items is performed in different ways depending on the type of list. A scrollable list allows 
multiple items to be selected.  To select items in a scrollable list, set the focus to the list, use the arrows to 
set the focus to the desired item, and then press the space bar to highlight the item.  A drop-down list 
allows only one item from a list to be selected.  To select the desired item from a drop-down list, set the 
focus to the list and use the arrow keys to highlight the desired item. 

Selection of option buttons and check boxes may be made in two ways.  If an option button or check box 
caption has an underlined letter, holding down the Alt key and pressing the underlined letter will select 
the item.  Option buttons and check boxes may also be selected by setting the focus to them and using the 
arrow keys to highlight the desired item.  For option buttons, this will automatically select the button.  For 
check boxes, the space bar must be pressed to select the highlighted item. 

If a form contains layered tabs of information, a tab may be moved to the front by holding down the Alt 
key and pressing the underlined letter in the caption of the desired tab. 

Toolbars 
 

Toolbars are used in WinHSPF to provide quick access to the most frequently used functions.  When 
applicable, the toolbars are located in close proximity to the control(s) with which their functions are 
associated.  This allows a single click of a nearby button to perform a function, rather than moving to the 
top of the form to pull down a menu title and select a menu item.  The toolbar buttons contain graphical 
images to assist the user in recalling what each button does.  Additionally, toolbar buttons contain 
tooltips, which provide a text description of each button when the mouse pointer is held over the button 
for a brief moment. 

Common Dialogs 
 

Some interactions that are routinely performed in the Windows interface are handled using common 
dialogs. These are forms that have consistent interfaces for routine tasks. The user will then be familiar 
with the form each time one of these tasks are performed. Within WinHSPF, the tasks performed using 
common dialogs are retrieving or saving a file. 

In WinHSPF, the user is frequently prompted for file names when saving or retrieving a file. The list at 
the top of the form (labeled either Save in or Look in) displays the current directory path. Use of the pull-
down arrow on this list allows the user to move to any directory above the current one. Directories below 
the current one are displayed in the large middle box. The desired directory is selected by double clicking 
on it. The buttons to the right of the top list are used for (from left to right) moving up one directory level, 



WinHSPF 2.0 

6 

viewing the root desktop directory, creating a new directory (or folder), and specifying whether to display 
a standard or detailed list of the directories and files contained in the current directory. The middle box 
also displays any existing files of the file type specified. The file type specification is made in the list at 
the bottom of the form (labeled either Save as type or Files of type). The File name text box is used to 
enter the name of the file. Clicking on a file listed in the middle box will put the name of the file in the 
File name box. A file is selected either by double clicking a file name in the middle box or by filling in 
the File name box and clicking the Save button or the Open button. Selecting an existing file during a 
save will cause a prompt to be displayed confirming that it is all right to overwrite the file.  

 

Help System 
 

There are various levels of Help within WinHSPF and they may be accessed in different ways. The Help 
menu title on the main WinHSPF form has two menu items: About and Contents. The About item is used 
to display a summary of the version of WinHSPF being run. The Contents item is used to bring up a 
window that allows the user to move throughout the entire WinHSPF help file. The user may move 
through the help file by using the hierarchical structure or the index of help topics. 

Context-sensitive access to the WinHSPF help file is provided through the F1 key. Pressing the F1 key 
from any form will display the relevant topic in the help file. 

An additional level of help that pertains to HSPF is also available.  This help information is available 
when editing a table of the HSPF UCI file.  Help will be displayed that pertains to the model parameter 
being edited. 
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System Overview 
 

This section includes information relating to the system hardware and software requirements, 
downloading the program and documentation, architecture, special files, and sample data. 

System Requirements 
 

WinHSPF requires a computer running Windows 95/98, Windows NT Version 4.0 or higher, or Windows 
2000. The minimum platform configuration is a Pentium or equivalent processor running at 200 
megahertz with 64 megabytes of memory, at least 100 megabytes of free disk space, and display 
resolution of at least 1024 x 768. For optimal performance, a Pentium II processor running at 400 
megahertz or faster with at least 128 megabytes of memory, 100 megabytes of free disk space, and 
display resolution of 1280x1024 is recommended. A color printer is also recommended. 

Obtaining WinHSPF 
 

WinHSPF may be obtained through the internet by accessing the US Environmental Protection Agency’s 
BASINS page.  From this page follow the instructions for downloading the software and installing it on 
your machine.  The manual, containing the same text and figures found in the help file, is included with 
the software. 

Architecture 
 

Object design was key in development of WinHSPF.  An object was created to store all of the information 
that is normally contained within the UCI file.  This UCI object is accessible throughout WinHSPF, and 
enables the software to easily access model parameter values.  All of the data traditionally stored in the 
UCI file are now stored in the UCI object in memory.  When the user accesses an existing UCI file, the 
UCI file is read and translated into the UCI object.  WinHSPF then uses this UCI object throughout the 
program.  When the UCI information is saved, the contents of the UCI object are translated back into the 
UCI file format. 

The HSPF model code was compiled into a dynamic link library (dll) for access by WinHSPF.  A small 
set of subroutines was developed to interface between the Visual Basic code and the existing HSPF 
Fortran routines.  Similarly, the timeseries data objects within WinHSPF use some calls to the Watershed 
Data Management (WDM) Fortran library of subroutines for time-series management.  This scheme 
allowed the well-tested and well-documented WDM code to be preserved. 
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BASINS Files 
 

WinHSPF uses a series of files from BASINS for creating a new project.  These files are intended to be 
produced using the BASINS GIS interface, but since they are text files, they may be built manually.  
Once a new project has been created, these files will no longer be needed by the project. 

The following sections provide detailed descriptions of each of these files and their contents.  For 
examples of these files, see BASINS File Samples within the Appendix.  The following is a list of the 
files: 

• Watershed File - *.wsd 

• Reach File - *.rch 

• Channel Geometry File - *.ptf 

• Point Sources File - *.psr 

 

Watershed File 
 

The Watershed File has a .wsd extension.  This file contains information related to the amount of each 
land use contributing to each reach.  This file is written from BASINS and is used in creating a new 
WinHSPF project. 

The Watershed File is a space-delimited ASCII file, with one or more spaces used to separate fields.  
Each record of the file contains the following information: 

• LU Name (land use name, used as LSID in PERLND/IMPLND GEN-INFO table) 

• Type (1=impervious/2=pervious, used to specify PERLND vs IMPLND) 

• Watershed-id (used to connect each land use to a reach) 

• Area (in acres, used as area factor in SCHEMATIC block) 

• Slope (used as SLSUR in PERLND PWAT-PARM2/IMPLND IWAT-PARM2 table) 

• Distance (in ft, used as LSUR in PERLND PWAT-PARM2/IMPLND IWAT-PARM2 table) 

An example of the Watershed File is found in the Watershed File section of the Appendix. 

The Slope and Distance fields are derived from the fields ‘Slo1’ and ‘Len1’, respectively, in the 
Subbasins shape file.  These values are computed during watershed delineation. 
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Reach File 
 

The Reach File has an .rch extension.  This file contains information related to each reach and the 
connections between reaches.  This file is used in creating a new WinHSPF project. 

The Reach File is a space-delimited ASCII file.  Each record of the file contains the following 
information: 

• Rivrch (reach id) 

• Pname (reach name, used as RCHID in RCHRES GEN-INFO table) 

• Watershed-ID (used to connect each reach with associated land segments) 

• HeadwaterFlag 

• Exits (number of exits, used as NEXITS in RCHRES GEN-INFO table) 

• Milept 

• Stream/Reservoir Type (S-stream/R-reservoir, used to set LKFG in RCHRES GEN-INFO table) 

• Segl (segment length in miles, used as LEN in RCHRES HYDR-PARM2 table) 

• Delth (delta h in ft, used as DELTH in RCHRES HYDR-PARM2 table) 

• Elev 

• Ulcsm 

• Urcsm 

• Dscsm (downstream reach id, used to establish connectivity for SCHEMATIC block) 

• Ccsm 

• Mnflow 

• Mnvelo 

• Svtnflow 

• Svtnvelo 

• Pslope 

• Pdepth 

• Pwidth 
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• Pmile 

• Ptemp 

• Pph 

• Pk1 

• Pk2 

• Pk3 

• Pmann 

• Psod 

• Pbgdo 

• Pbgnh3 

• Pbgbod5 

• Pbgbod 

• Level 

 

Many of the fields in this file are not used by WinHSPF.  Those fields that are used by WinHSPF are 
noted above. 

An example of the Reach File is found in the Reach File section of the Appendix. 

Channel Geometry File 
 

The Channel Geometry File has a .ptf extension.  This file contains information related to the channel 
cross sections and lengths for each reach.  This file is used in creating the FTABLES for a new WinHSPF 
project. 

The Channel Geometry File is a space-delimited ASCII file.  Each record of the file contains the 
following information: 

• Reach Number 

• Length (ft) 

• Mean Depth (ft) 

• Mean Width (ft) 



 User's Guide 

 11 

• Mannings Roughness Coeff. 

• Long. Slope 

• Type of x-section 

• Side slope of upper FP left 

• Side slope of lower FP left 

• Zero slope FP width left (ft) 

• Side slope of channel left 

• Side slope of channel right 

• Zero slope FP width right (ft) 

• Side slope lower FP right 

• Side slope upper FP right 

• Channel Depth (ft) 

• Flood side slope change at depth 

• Max. depth 

• No. of exits 

• Fraction of flow through exit 1 

• Fraction of flow through exit 2 

• Fraction of flow through exit 3 

• Fraction of flow through exit 4 

• Fraction of flow through exit 5 

An example of the Channel Geometry File is found in the Channel Geometry File section of the 
Appendix. 
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Point Sources File 
 

The Point Sources File has a .psr extension.  This file contains information related to point source 
dischargers in the watershed, the pollutants output and the loading rates.  This file is used in creating point 
source time-series data sets in the project WDM file. 

The Point Sources File is a space-delimited ASCII file.  The first record of the file contains an integer 
number of point source dischargers.  Following this line is a blank line, followed by a header line.  Then 
the next n lines, where n is the number of point source dischargers, contain the following information: 

• Facility Name 

• Npdes 

• Cuseg 

• Mi 

 

The following line is blank, followed by a header line.  The rest of the file consists of a series of records 
containing the following information: 

• Ordinal Number 

• Pollutant 

• Load (lbs/hr) 

An example of the Point Sources File is found in the Point Sources File section of the Appendix. 

Sample Data 
 

Sample data have been provided with the WinHSPF installation package for learning and demonstration 
purposes.  No assumptions are to be made concerning the accuracy of the data, including the HSPF User 
Control Input (UCI) file that might be created from this test data. 
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Tutorial 
 

This section presents detailed examples illustrating the use of WinHSPF. The most effective way to use 
this section is by running WinHSPF and working through the lessons. This assumes that WinHSPF and its 
associated example data have been installed on your computer. For instructions on how to obtain and 
install WinHSPF, see the Obtaining WinHSPF section. 

• Lesson 1 shows how to build a new UCI file from using the files output from the BASINS HSPF 
option. 

• Lesson 2 shows how to open any existing UCI file in WinHSPF. 

• Lesson 3 shows how to execute the HSPF Model and review the results. 

• Lesson 4 shows how to specify timeseries to be output from the simulation. 

• Lesson 5 shows how to change HSPF parameters and save the changes as a new scenario. 

• Lesson 6 shows how to model a watershed management practice. 

• Lesson 7 shows how to add point source data to a simulation from a variety of data sources. 

• Lesson 8 shows how to modify the specified meteorological data contributing to each model segment. 
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Lesson 1:  Creating a New Project 
 

Creating a new WinHSPF project means creating a new UCI file, since all WinHSPF project information 
is stored in the UCI file.  When using WinHSPF from the BASINS system, the user will automatically 
enter WinHSPF at the Create Project window.  When using WinHSPF apart from the BASINS system, 

the user will have to choose Create from the File menu or click on the  icon on the toolbar to enter 
the Create Project window.  Whichever way WinHSPF is started, the Create Project feature assumes 
that the user has created a set of intermediate files from BASINS (.wsd, .rch, .psr, and .ptf) that transfer 
data from the BASINS GIS interface to WinHSPF. 

As WinHSPF starts, an initialization process begins, during which the contents of several files are read 
into memory, including the files ‘HspfMsg.mdb’ and ‘starter.uci’.  The progress will be visible in the 
status window. 

 

After initialization is complete, either one of two windows will appear, depending upon the way 
WinHSPF was started.  If the user has started WinHSPF independently from BASINS, the Hydrological 
Simulation Program - Fortran (HSPF) window, the main WinHSPF window, appears. 
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The user should select the File menu and then choose the Create option. At this point the window entitled 
WinHSPF - Create Project will appear. 

If coming from BASINS the user is immediately taken to the WinHSPF - Create Project window. 

 

The Create Project window contains Select buttons for three types of files, a list for selecting a met 
station, and a set of radio buttons for choosing between two land surface segmentation options.  The first 
type of file available for selection is the BASINS Watershed File. When coming from BASINS, the text 
box next to this name will already be filled in with the name of the ‘.wsd’ file for the current BASINS 
project.  The second type of files that can be selected are the Met WDM Files.  Up to 3 met WDM files 
can be selected.  These files generally reside in the ‘met_data’ folder, but actually any other WDM file 
could be referenced as a met WDM file.  The third type of file is the Project WDM File.  This file will 
contain the point source inputs to the model as well as any output time series from the HSPF simulation. 

If the box next to BASINS Watershed File does not contain a file name, select tutorial.wsd from the 
‘tutorial’ subdirectory.  To do this, click the Select button next to the BASINS Watershed File text, and 
in the following file dialog, select the ‘tutorial.wsd’ file.  Click the Open button, and the name of this file 
will appear in the BASINS Watershed File box in the Create Project window. 

Next, select tutorial.wdm from the ‘met_data’ subdirectory as the Met WDM File.  The file name will 
now appear in the box next to Met WDM Files.  Then select project.wdm from the ‘modelout’ 
subdirectory as the Project WDM File.  If this file does not already exist, type the name in the file name 
box and it will be created . 

Once one or more met WDM files are specified, the Initial Met Station list will be populated with the 
identifier corresponding to met stations available for use in the new HSPF project.  One item from this list 
should be selected in order to have some met data included in the HSPF simulation.  (After the new 
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project has been created other met stations may be added through the WinHSPF interface.)  Leave the 
first option in this list selected for this tutorial. 

In the Model Surface Segmentation radio buttons, the Grouped option creates a single model segment 
(one PERLND/IMPLND per land use) for all collective subbasins, and the Individual creates a single 
model segment for each subbasin.  For example, assume the watershed delineation contains three 
subbasins, and each subbasin contains a land use called ‘Forest’.  Using the Grouped option will result in 
one ‘Forest’ PERLND, say PERLND 101, contributing to each of the three delineated reaches.  Using the 
Individual option, on the other hand, will result in three ‘Forest’ PERLNDs, say PERLND 101, PERLND 
201, and PERLND 301, with each of these three PERLNDs contributing to one delineated reach.  For this 
tutorial leave the selection set to Grouped. 

 

Once the user has specified all of the information required in the Create Project window, click the OK 
button.  Doing so will call the algorithms that build the new UCI file. The new UCI file is written to the 
BASINS project folder containing the .wsd file. Portions of the UCI file are created using the .rch, .psr, 
and .ptf files created when the New HSPF Project option was selected in the BASINS GIS interface. 

Data sets are created in the project wdm file for the point sources included in the .psr file.  The units of 
the data in these sets are lbs/hour for all constituents except flow, which is in cfs.  For each point source 
data set, the scenario attribute is set to OBS-PT, and the location attribute is set to RCH plus the reach 
number.  These attributes are used by the WinHSPF Point Sources tool to identify point source data sets. 
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Initial values for some parameters important to HSPF hydrology calibration are extracted from the 
‘starter.uci’ and deposited into the new UCI file.  After the UCI is created the main WinHSPF window 
appears.  A schematic diagram of the watershed appears in the main WinHSPF window. 

 

Once the UCI file creation process is complete, the set of files from the BASINS GIS interface (.wsd, 
.rch, .psr, and .ptf) are no longer used. 
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Lesson 2: Opening an Existing Project 
 

Opening an existing WinHSPF project means opening an existing UCI file.  Any valid UCI file may be 
opened by WinHSPF. 

As WinHSPF starts, an initialization process begins, during which the contents of several files are read 
into memory, including the files ‘HspfMsg.mdb’ and ‘starter.uci’.  The progress will be visible in the 
status window.  After initialization the main WinHSPF window appears, entitled Hydrological 
Simulation Program - Fortran (HSPF). 
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To open an existing UCI file, choose Open from the File menu or click the icon on the toolbar.  In 
the Open Project dialog select the tutorial.uci file from the ‘tutorial’ subdirectory then click the Open 
button. 

 

As a UCI file is opened, a status window will provide information related to the progress of reading and 
interpreting the UCI file.  The status window will minimize after the UCI has been processed.  A 
schematic diagram of the watershed will appear in the main WinHSPF window. 

 



WinHSPF 2.0 

20 

Lesson 3:  Executing the HSPF Model 
 

Once a project has been created or opened in WinHSPF, running the HSPF model is simple. From the 
Hydrological Simulation Program - Fortran window, either select the Functions:Run menu item or 

click the  icon on the toolbar. Once the user clicks this button, HSPF begins reading and 
interpreting the UCI file. 

 

After this interpretation phase is complete, a status window will appear, showing the progress of the 
simulation. 

 

Once the simulation is complete, the status window will disappear. 

In case of error during the execution of HSPF, look at the contents of the status window. More detailed 
messages may be found by clicking the Output button in the status window. 



 User's Guide 

 21 

 

Also be sure to check for run interpreter error messages, which would be written to the HSPF echo file.  
For a project created with WinHSPF, the echo file should be in the same folder as the UCI file.  The echo 
file name will consist of the base name of the project followed by a ‘.ech’ extension. 
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Lesson 4:  Specifying Output Timeseries 
 

WinHSPF output timeseries are stored in data sets in the Project WDM File.  Output data sets associated 
with one UCI file are tagged with a common attribute, so that WinHSPF can identify which data sets are 
associated with a particular UCI file.  This WDM attribute is known as the scenario name; it is also used 
in GenScn to identify timeseries of a common scenario. 

WinHSPF has two ways to specify output timeseries.  The first way is through the Output Manager.  The 
Output Manager is accessed either by choosing the Functions:Output menu option or by clicking 

the  icon on the toolbar. The Output Manager window will appear containing a set of radio buttons 
and a list of output locations.  The radio buttons are used to specify which of the three types of output to 
view.  Clicking on one of the radio buttons produces a list of locations where that output has been 
specified. 

 

The first output type is Hydrology Calibration.  This button will already be selected when entering the 
Output Manager.  Underneath the radio buttons is a text box explaining which output timeseries will be 
generated during the HSPF model run.  There are eight output timeseries required by the Expert System 
for HSPF Hydrology Calibration, known as HSPEXP.  The list below the text box will be empty when 
running this tutorial, because by default no hydrology calibration locations are specified.  Adding 
calibration locations to this list is accomplished by clicking on the Add button.  Click this button.  A 
window will be produced containing a list of available calibration locations, i.e. the reaches of the 
watershed, along with two text fields.  Choose ‘Rchres 3’ from the list.  The WDM Location ID will be 
used in GenScn for  the user to specify locations for analysis.  Enter ‘RCH3’ or up to eight characters of 
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text to use as the location identifier.  Use 1000 as the base data set number. The new data sets will be 
numbered as the available data sets following that number. 

 

Click OK from this window, and you will be back in the Output Manager window. As you return to the 
Output Manager window, eight new time-series data sets are created in the project WDM file, as 
required by the Expert System for HSPF Hydrology Calibration, known as HSPEXP.  The UCI in 
memory is modified to include the appropriate Copy operation as well as the appropriate External 
Targets, Schematic, and Mass-Link Blocks.  The Output Manager window now shows an output 
hydrology calibration location at RCHRES 3. 
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Click the Flow radio button and notice that be default Flow is specified for output at the outlet of the 
watershed, RCHRES 3.  Flow output can be added by means similar to those used to add a calibration 
location. 

 

The Other radio button is used to add other outputs. 

 

Click Add to add additional outputs from this simulation.  A window will be produced containing a list of 
model segments. 
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Choose ‘RCHRES 3’, and a list of Group and Members will appear.  This list contains all valid Group 
and Member pairs that can be output from this operation given the current active sections of this 
operation.  Choose ‘Hydr:Stage’ to output ‘Stage’ for this reach.  The gray text box in the middle of the 
form displays the Operation and Group/Member selections.  Click OK to add this output specification. 
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Notice that ‘Stage’ is now listed in the Output Manager.  Copy is used to copy output specifications  from 
one model segment to another.  Click Copy, and a window will appear containing a list of operations with 
output specified. 

 

Choose ‘RCHRES 3’ as the ‘From’ operation, and then choose ‘RCHRES 2’ as the ‘To’ operation.  Then 
click OK.  Notice now in the Output Manager that ‘Stage’ is also specified for output from RCHRES 2. 

 

Click Close to return to the main WinHSPF window. 
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Another way to specify output timeseries is through editing the External Targets block.  This functionality 
is accessed either by choosing the Edit:EXT TARGETS menu option or by choosing EXT TARGETS in 
the Input Data Editor.  Click on the Edit menu, then select the EXT TARGETS option. 

 

The Edit External Targets window contains a grid showing all External Targets entries. Each row 
contains the specifications for one output time series; each column of the grid represents a distinct 
specification.  The gray text box in the middle of the form provides a description of the currently selected 
specification.  To add a new entry, click on the Add button.  A new record will appear in the list.  Double 
click in the left-most column of the bottom row, and choose ‘Perlnd’.  Double click in the next column, 
and choose ‘101’.  Proceed through the rest of the fields, adding values as shown in the image below.  For 
this example, be sure to use a data set number that does not already exist in your WDM file. 

 

Once you have added values for each field, click the Apply button.  The Add Data Set window will 
appear, which indicates that the data set number you have selected does not yet exist.  The user may edit 
attribute values for this new data set if desired.  Click the OK button to accept the values for this new data 
set. 
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At this point you have added a new output timeseries.  Click OK in the Edit External Targets window 
to return to the main WinHSPF window. 
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Lesson 5:  Changing HSPF Parameters and Saving the Revised Project 
 

With a project active in WinHSPF, the user may wish to modify some HSPF parameters and save the 
changes.  This situation occurs often during model calibration.  This lesson demonstrates how to change 
HSPF parameters and save the changes. 

 

WinHSPF permits the user to change HSPF parameters in a variety of locations throughout the software.  
Double click on the Forest Land box in the Land Surface tab of the main WinHSPF window.  If you 
selected the ‘Grouped’ model segmentation in Lesson 1, the Edit Operation window will appear for 
PERLND 101. 
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In the Edit Operation window, double click on Pwat-Parm2.  A new window will appear for editing the 
values of the Pwat-Parm2 table for this Perlnd operation. 

 

Click on the first row of the LZSN column.  Edit the LZSN value, making it 13.1. After entering the 
number click the OK button.  Click the OK button for the Edit Operation window as well. 

At this point you have made a change to the UCI, but the file has not been saved.  To save the changes, 
select the File menu and choose the Save option.  This option will overwrite the previous version of the 
UCI with the revised version. 
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The user might prefer to save the changes to a new UCI file.  To do so, choose the Save As option from 
the File menu.  The  Save As window will appear, in which the user may specify the name of the new 
project. 

 

In addition to entering the name of the new UCI file, the user may also specify the other details about the 
new project.  The Browse button is used to set the path name where the new UCI is to be stored.  The 
other parameters pertain to the WDM data sets specified as outputs from this simulation. 

When the UCI file is saved under a new name, WinHSPF scans the project WDM file to identify any 
WDM data sets associated with the previous UCI file name.  For each data set identified, a new WDM 
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data set is built to contain the output from the new UCI file, and the External Targets block is modified to 
use these new data set numbers.  The Base DSN field in conjunction with the Relative/Absolute radio 
buttons is used to specify the new data set numbers for the new project.  A Base DSN of 1000 specified 
‘Absolute’ means that the new data sets will be numbered using the first available data set numbers after 
1000.  A Base DSN of 1000 specified ‘Relative’ means that the new data sets will be numbered as the 
next available data set number after the current data set number plus 1000 (for example data set 101 will 
be numbered 1101). 

Specify the name for the new UCI file, and click the Save button.  WinHSPF will modify the project 
WDM file and the External Targets block of the new UCI file as described above.  Once WinHSPF 
completes these modifications, the new UCI file is written to disk. 
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Lesson 6:  Modeling a Watershed Management Practice 
 

With a project active in WinHSPF, the user may wish to make significant changes in the HSPF input 
sequence and save this modified input sequence under a new WinHSPF project name.  This situation 
might occur if the user is modeling a watershed management practice.  This lesson demonstrates how to 
make changes to the project to model a sediment BMP and save the changes to a new WinHSPF project 
name.  (An alternate way to add BMPs is through use of the BMP Editor.  See the Best Management 
Practices Editor for more details.) 

Watershed management practices can be modeled in HSPF using the BMPRAC operation.  Adding a 
BMPRAC operation requires several steps, including adding the BMPRAC operation to the Operation 
Sequence block, adding the appropriate tables within the BMPRAC block, and adding the appropriate 
connections. 

WinHSPF provides assistance in adding the BMPRAC operation and required BMPRAC tables, but the 
appropriate Mass-Links must already exist in the Mass-Link block.  This tutorial assumes that the 
appropriate Mass-Links do not already exist. 

The user must first add the necessary Mass-Links.  From the main WinHSPF window, click on the Edit 
menu, and select the Mass-Link option. 

 

The Edit Mass-Link Block window will appear. 
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Click the Add New button in the top right corner to add a new Mass-Link. A new Mass-Link will appear 
with no records in it. 

 

Click the Add button to add a record to this Mass-Link. 
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This new Mass-Link will be used for the BMPRAC to RCHRES connection.  Double click in the left-
most column and choose the BMPRAC operation.  Click in the column to the right and enter ‘1’ as the 
operation number.  Proceed through the rest of the columns adding text as shown in the following image.  
When finished click the Apply button. 
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The same process is needed for the PERLND to BMPRAC connection.  Click the Add New button to add 
a new Mass-Link.  A new Mass-Link will appear with no records in it.  Click the Add button three times 
to add three records to this Mass-Link.  Proceed through the rows and columns adding text as shown in 
the following image.  When finished click the Apply button. 

 

The same process is needed for the IMPLND to BMPRAC connection.  Click the Add New button to add 
a new Mass-Link.  A new Mass-Link will appear with no records in it.  Click the Add button three times 
to add three records to this Mass-Link.  Proceed through the rows and columns adding text as shown in 
the following image.  When finished click the OK button to return to the main WinHSPF window. 
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The Mass-Links have now been added, and the user may proceed to add the new operation.  From the 
main WinHSPF window, click on the Edit menu, and select the Opn Sequence option. 

 

The Edit Opn Sequence Block window will appear. 
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We will add the new BMPRAC operation upstream of RCHRES 1.  Click on the row containing 
RCHRES 1.  Then click the Add button. 

 

The Add Operation window will appear.  Specify the parameters in this window as shown in the 
following image.  Be sure to select ‘BMPRAC’ as the operation type, ‘1’ as the number, type ‘sediment 
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bmp’ as the description, choose all upstream operations, and choose ‘RCHRES 1’ as the downstream 
operation.  Then click the OK button. 

 

The new BMPRAC operation will appear in the Edit Opn Sequence Block window.  Click OK to return 
the main WINHSPF window. 

 

The watershed schematic in the main window now contains the new BMPRAC operation. 
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The new BMPRAC operation does not have any land area contributing to it yet.  Click on the Edit menu, 
and select the Schematic option. 



 User's Guide 

 41 

 

The Edit Schematic Block window will appear.  Notice the number of acres of PERLND 101 
contributing to RCHRES 1.  Enter this number of acres in the AreaFact column of the PERLND 101 to 
BMPRAC 1 row.  Then click on the PERLND 101 to RCHRES 1 record, and click on the Remove button 
to remove this record from the Schematic block.  Proceed through the rest of the records contributing to 
BMPRAC 1, so that the Schematic block appears as follows.  Then click the OK button to return to the 
main WinHSPF window. 
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Notice in the watershed schematic that land area now contributes to BMPRAC 1. 
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The last step in adding the new management practice is to add the necessary tables to the BMPRAC 
block.  Double-click on the BMPRAC 1 box in the watershed schematic.  The Edit Operation window 
will appear for BMPRAC 1. 

 

Notice that the required table ‘GEN-INFO’ is missing.  Select the name ‘GEN-INFO’ and then click the 
Add button to add this table.  The name ‘GEN-INFO’ will move to the list of tables that are present. 

 

Select the name ‘GEN-INFO’ and then click the Edit button to edit this table.  The Edit 
BMPRAC:GEN-INFO window will appear.  The default values for this table are acceptable.  Type in a 
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name for the BMPID and click the OK button to return to the Edit Operation window.  

 

Select the name ‘SED-FRAC’ and then click the Add button to add this table. The name ‘SED-FRAC’ 
will move to the list of optional tables present. 

 

Select the name ‘SED-FRAC’ and then click the Edit button to edit this table.  The Edit 
BMPRAC:SED-FRAC window will appear.  Enter 0.4 for SEDFRAC 1, 0.5 for SEDFRAC 2, and 0.6 
for SEDFRAC 3.  These numbers represent the removal fractions for sand, silt, and clay, respectively.  
Click the OK button to return to the Edit Operation window. 
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From the Edit Operation window, click the OK button to return to the main WinHSPF window.  We 
have now completed the process of adding a watershed management practice.  To save the project with 
the new BMP, click on the File menu, and select the Save As option.  Enter the name of the new sediment 
BMP UCI file, and click the OK button. 
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Lesson 7:  Adding Point Source Data 
 

With a project active in WinHSPF, the user may wish to add point source data to the project WDM file.  
The user may also wish to edit point source data.  This lesson demonstrates how to add point source data 
on the project WDM file, and how to edit existing point sources. 

Upon creation of a new project, point source data is written to the project WDM file for all point sources 
and constituents specified in the BASINS point sources file.  Click on the  button on the toolbar and 
the following window will appear: 

 

The absence of a grid on the bottom portion of the window indicates that there are currently no point 
source data for the project.  The three buttons at the top of the window provide ways to add such data to 
the project WDM file. 

 

• Create - allows the user to manually create a point source data set 

• Import - allows the user to import a MUTSIN point source data file 

• Convert - converts any MUTSIN point source files referenced in the HSPF input sequence to WDM 
data sets 
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Click on the Create button and enter the following information.  Values for the Scenario and Daily Load 
fields must be typed in while the other 3 fields are selected from drop-down lists. 

 

Once the values have been entered, click the OK button to create the new point source in the project 
WDM file and return to the main Point Sources window.  The new point source data set is now displayed 
in the grid. 

 

Now click on the Import button and enter the following information.  Select tutorial.MUT from the 
‘\BASINS\data\tutorial\HSPF’ subdirectory, type in the extension of the Scenario name, and select the 
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Reach from its drop-down list box.  The Facility field is automatically filled in with text from the import 
file. 

 

Once the values have been entered, click the OK button to import the new point sources into the project 
WDM file and return to the main Point Sources window. 
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Select a field in the first row containing the information associated with Benzene, then click on the 
List/Edit button.  The following form appears: 

 

Highlight the value fields for 1970/01/01 to 1970/01/16 then type in the value 15. 
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Click on the X in the top right corner of the window and the following message box will prompt you to 
save the changes to the data set. 

 

Click on the ‘No’ button.  From the ‘File’ menu, choose ‘Save Changed’, and the following dialogue box 
appears: 
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Click on the OK button without editing any values and the following message box appears: 

 

A final message box appears confirming that the edits were successfully saved to the project WDM file 
then the interface returns to the Point Sources window.  Click on the OK button to return to the main 
WinHSPF form from there.  Six new point source data sets have been added to the project WDM file. 

See the Point Sources section of the online help for more detailed information about adding point source 
data to the project. 
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Lesson 8:  Modifying Meteorological Data 
 

With a project active in WinHSPF, the user may wish to alter the time span simulated during the HSPF 
run or edit the composition of the meteorological segments contributing to the HSPF operations.  Both of 
these tasks can be accomplished via the Simulation Time and Meteorological Data form.  This lesson 
demonstrates how to: 

 

• modify the time span of the HSPF simulation run 

• create additional met segments 

• edit which met segments contribute to which operations 

While running the tutorial project distributed with WinHSPF, click on the icon on the toolbar.  The 
following window appears: 
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Click on the Start Year and enter a value of 1975.  Now click on the the End Year and enter a value of 
1980.  The HSPF simulation will now only encompass this six-year span. 

Now modify the met segments contributing to the operations.  Double-click any field in the Met Seg ID 
column.  The drop-down list contains only one met segment, indicating that there is only one such 
segment available for application to the corresponding operation.  With a Met Seg ID still selected, click 
on the Edit button at the top left of the Met Segments frame.  The Edit Met Segment form appears.  
Notice that the user may change the way this Met Segment is defined by changing the values in this grid, 
such as changing the Evap DSN. 

 

Click on the Cancel button and return to the Simulation Time and Meteorological Data form.  Now 
click on the Add button at the top right of the Met Segments frame and the Add Met Segment form 
appears.  In the drop down list at the top of the window, choose the second item. 
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Notice that the user may customize this new Met Segment by editing the fields in this grid.  Click on the 
OK button when the selections are complete and return to the Simulation Time and Meteorological 
Data form.  Now double-click on the first two rows in the Met Seg ID column and select the recently 
created met segment PA007229. 
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When the selections are complete, click the OK button and return to the main form.  The newly created 
met segment PA007229 will now affect the PERLND 101 and PERLND 102 operations during a HSPF 
simulation run. 
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Detailed Functions 

Main WinHSPF Window 
 

The main window of WinHSPF contains a menu, a tool bar, a vertical tab strip, a schematic of the 
watershed, and an auxiliary table.  The tab strip, watershed schematic, and auxiliary table are not active 
until a project is active (i.e. a UCI file is opened).  The information on the tab strip as well as the auxiliary 
table pertain to the open project, that is the project represented by the watershed schematic. 

The buttons on the tool bar represent various ways of interacting with the open project. The left most 
buttons can be used for creating, opening, and saving a project.  The right most button on the tool bar is 
used to perform the simulation, i.e. run HSPF.  The other buttons on the tool bar are used to view and/or 
modify the contents of various portions of the open project. 

The tab strip contains three tabs.  The tabs work in conjunction with the figures in the watershed 
schematic to display information about the project in the auxiliary table. The tabs are used to specify 
whether to display information related to land surfaces, met segments, or point sources.  Highlighting 
some items in the tab strip in conjunction with highlighting some figures in the watershed schematic 
results in some related data being summarized in the auxiliary table.  For example, from the Land 
Surface tab, click on the ‘Forest Land’ surface and the ‘Rchres 1’ figure.  The auxiliary table will show 
the acres of Forested area contributing to Rchres 1. 
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Clicking on the Met Segs tab shows which met segments are associated with each reach. The auxiliary 
table will show information for the selected met segment contributing to the selected reach.  Information 
in the auxiliary table includes the constituent name, WDM data set number, associated multiplication 
factor for the PERLND/IMPLND segments, associated multiplication factor for the RCHRES segments, 
and the transformation function used to adjust the time dimension of the data units as necessary. 

 

Similarly, clicking on the Point Sources tab shows the point sources that are associated with each reach.  
The auxiliary table will show information for the selected point source and reach combination. 
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Edit Operation 
 

The Edit Operation window provides a powerful interface to an HSPF operation.  There are two ways to 
produce this window.  One is to select the OPN SEQUENCE option from the Edit menu, which displays 
the Edit Opn Sequence Block window.  Select the desired operation from the Name column then click 
on the Edit button. 

 

The other way to produce the Edit Operation window is to double-click on a figure in the watershed 
schematic or on an item on the Land Surface tab of the main form.  If the model segmentation is 
‘Individual’, the individual land segments can be accessed by selecting OPN SEQUENCE from the Edit 
menu. 

The Edit Operation window contains a tab strip, a frame containing a row of check boxes, and a series of 
command buttons.  All of the information in the Edit Operation window pertains to the current 
operation, which is referenced in the window name. The tab strip contains tabs for tables, special actions, 
input timeseries, and output timeseries.  Active sections are turned on or off for this operation through use 
of the row of check boxes.  Each of the active sections corresponds to a module within the HSPF model.  
The user may incorporate these modules into the simulation run by checking the box next to the 
appropriate section. 

If a RCHRES operation is selected, the Edit Operation window will appear as follows: 
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The ten Active Sections are: 

• HYDR - simulate hydraulic behavior 

• AD - prepare to simulate advection of fully entrained constituents 

• CONS - simulate conservative constituents 

• HT - simulate heat exchange and water temperature 

• SED - simulate behavior of inorganic sediment 

• GQAL - simulate behavior of generalized quality constituent 

• OX - simulate primary DO and BOD balances 

• NUT - simulate primary inorganic nitrogen and phosphorus balances 

• PLK - simulate zooplankton populations and associated reactions 

• PH - simulate pH, carbon dioxide, total inorganic carbon, and Alkalinity 

 

If a PERLND operation is selected, the Edit Operation window will appear as follows: 
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The twelve Active Sections are: 

• AIRT - temperature correction for elevation difference 

• SNOW - simulate accumulation and melting of snow and ice 

• PWAT - simulate water budget for a pervious land segment 

• SED - simulate production and removal of sediment 

• PST - estimate soil temperatures 

• PWG - estimate water temperature and dissolved gas concentrations 

• PQAL - simulate water quality constituents 

• MSTL - estimate moisture content of soil layers and fractional fluxes 

• PEST - simulate pesticide behavior in detail 

• NITR - simulate nitrogen behavior in detail 

• PHOS - simulate phosphorus behavior in detail 

• TRAC - simulate movement of a tracer 

 

If an IMPLND operation is selected, the Edit Operation window will appear as follows: 
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The six Active Sections are: 

• ATMP - temperature correction for elevation difference 

• SNOW - simulate accumulation and melting of snow and ice 

• IWAT - simulate water budget for an impervious land segment 

• SLD - simulate accumulation and removal of solids 

• IWG - estimate water temperature and dissolved gas concentrations 

• IQAL - simulate washoff of quality constituents 

 

As active sections are turned on or off, the lists in the Tables tab change to reflect the tables applicable to 
the active sections.  The four lists in the Tables tab show the required tables that are present, the optional 
tables that are present, the required tables that are missing, and the optional tables that are missing.  The 
user may add a table by selecting the table name in the list and clicking the Add button.  The user may 
remove a table by selecting the table name and clicking the Remove button.  Similarly, the user may edit 
a table by selecting the table name and clicking the Edit button, or by double-clicking the table name.  
The resulting Edit Table window allows the user to edit the table parameters in a grid. 
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From this window a user may view and modify which sections of HSPF are active, view and modify the 
tables present for this operation, and view a summary of input and output timeseries used by this 
operation.  Clicking on a table name allows the user to edit that table.  Within this window is encapsulated 
important HSPF operating logic to assist the user in building a simulation.  For example, the information 
in this window may alert a user to required tables or timeseries that are missing. 

 

The Tables tab is useful for the user to identify which tables are required or missing for the current set of 
active sections, as well as providing a way to add, remove, and edit tables. 
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The Input Timeseries tab is similar to the Tables tab, except that the four lists pertain to Input 
Timeseries instead of Tables.  Input Timeseries are not added and removed using this window as tables 
are, but the contents of the lists show the user which timeseries are being used in the simulation and 
which are missing.  This functionality is especially useful when adding active sections to a simulation, 
and might help a user identify problems in a run resulting from required timeseries that are missing. 

For example, a user might have only the ‘Hydr’ section on, and then turn on the ‘Ox’ section. The 
information in the Input Timeseries tab shows that the required timeseries “HTRCH:TW’ is missing.  
This information would alert the user that the section ‘Htrch’ should be turned on, or that the timeseries 
‘HTRCH:TW’ should be input as an external source. 

 

The Output Timeseries tab is very similar to the Input Timeseries tab, except that output timeseries are 
listed. 

The Special Actions tab is not yet implemented.  When completed, this tab will allow the user to edit the 
Special Actions specific to this operation.  Until this option is completed, the Special Actions can be 
modified by editing the UCI file in a text editor. 
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Reach Editor 

The Reach Editor allows the user to edit select properties of each reach.  Clicking the button on the 
toolbar produces a window containing a grid of values for each reach.  Values include: 

• ID - RCHRES number as recognized by HSPF 

• Description - descriptive name of reach 

• Length - length of reach 

• Delta H - change in elevation across length of reach 

• DownstreamID - RCHRES number of downstream reach 

• Nexits - number of outlets from reach 

• Lake Flag - value is 1 if rchres is a lake 

These values may be edited, and the OK button may be clicked to save the changes and return to the main 
WinHSPF window.  The Cancel button may be used to return to the main window without saving 
changes. 

 

Clicking the FTables button produces a window from which the user may view and edit the values of 
each FTable.  The drop down list at the top of the window is used to select the desired FTable. 
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The FCurve button produces a graph of the FTable.  The features of the graph may be edited by using the 
menus on the graph. 

 

The Import From Cross Section button produces a window from which the user may enter cross section 
data for an FTable.  Clicking OK in this form results in a new FTable being calculated for the selected 
reach. 
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The variables in the Import From Cross-Section frame are defined in following diagram. 
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Cross-sectional data can be stored as BASINS Trapezoidal files (*.rtf).  Click the Open button on the 
Import From Cross-Section frame to open an existing *.rtf file or the Save button to create a new *.rtf file. 
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Simulation Time 

The Simulation Time button  on the toolbar produces the Simulation Time and Meteorological 
Data form, which allows the user to edit the simulation starting and ending dates and times, as well as the 
met segments used in this HSPF project. 

 

To edit the dates and times, simply click on the field for the year, month, day, hour, or minute and type in 
a value. 

The Met Segments section of the Simulation Time and Meteorological Data form contains grid with a list 
of the meteorological segments and the operations which they affect.  New met segments may be added 
by clicking on the Add button.  Existing met segments may be modified by clicking on the Edit button.  
To edit a met segment, highlight the desired segment in the Met Seg ID Column then click on the Edit 
button.  The Add Met Segment and Edit Met Segment forms are virtually identical in appearance, 
except that the Met Segment name in the ‘Add Met Segment’ form may be chosen from a drop-down list.  
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The precipitation data set defines the met segment and thus may not be edited in the Edit Met Segment 
form. 

 

 

The eight constituents listed in the first column of the grid constitute a full set of data for a met segment.  
The next three columns contain drop-down listboxes with all available selections for each column.  These 
columns should be filled out left to right because each successive field is dependent on the previous.  The 
WDM ID column lists the WDM files used by this project (there may be up to 4).  The TSTYPE column 
lists the types of time series available for the selected WDM file.  The DSN column lists the data set 
numbers of the time series available for the selected WDM file and time series type.  A real number 
should be typed in for the final 2 columns, which contain multiplication factors to be applied to the 
PERLND/IMPLND operations and to the RCHRES operations. 
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Values may be entered in the grid one at a time or they may be copied from an existing grid en masse.  To 
copy values from one grid to another: 

• bring up a full grid using the Edit button 

• highlight the block of values to be copied 

• type ‘ctrl-c’ to copy 

• bring up an empty grid using the Add button or another full grid using the Edit button 

• highlight the complete portion of the second grid where the values are to be pasted 

• type ‘ctrl-v’ to paste 

Once the desired changes have been made via the Simulation Time and Meteorological Data form, the 
OK button may be clicked to save the changes and return to the main WinHSPF window.  The Cancel 
button may be used to return to the main window without saving changes. 
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Land Use Editor 
 

The Land Use Editor allows the user to edit the amount of each land use contributing to each reach.  

Clicking the  button on the toolbar produces a window containing two list boxes, under which is a 
grid displaying area values connecting source operations to target operations.  The grid contains five 
columns: 

• SourceID - name of contributing source as recognized by HSPF 

• Source Description - description of contributing source 

• TargetID - name of target/reach as recognized by HSPF 

• Target Description - description of target/reach 

• Area - acreage of source contributing to target/reach 

 

The list box on the left represents the sources or land segments, and the list box on the right represents the 
targets or reaches.  The grid contains a row for each selected land segment contributing to each selected 
reach.  Reaches and land segments are represented in the grid if the name of the operation is in the 
Selected portion of the list box.  Operations can be moved back and forth between the Selected and 
Available portions of the list, and the contents of the grid automatically will change accordingly. 
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The area values may be edited, and text below the grid will indicate the original total area, the new total 
area, and the difference between these two.  This information provides the user with some information 
that allows the user to feel confident that the change was interpreted as desired. 

 

Once the values have been edited, the OK button may be clicked to save the changes and return to the 
main WinHSPF window.  The Cancel button may be used to return to the main window without saving 
changes. 
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Control Cards 
 

The Control Card Editor is accessed by choosing the Control option from the Functions menu or by 

clicking on the Control Card button on the toolbar.  The Control Window Selection window will 
appear, prompting the user to choose between the HSPF Activity Edit window or the old NPSM Control 
Card Editor.  Both schemes are available so that the user may have a choice of means. 

 

If the user chooses the HSPF Activity option, a window will be displayed containing a tab strip.  On each 
of the three tabs are the Activity tables for the PERLND, IMPLND, and RCHRES blocks.  Changes may 
be made to the entries in these tables, and then the user may click OK to exit and save the changes or 
Cancel to exit without saving the changes. 

 

If the user chooses the NPSM option, a window will be displayed containing a tab strip, similar to the 
HSPF Activity edit window.  The three tabs represent the PERLND, IMPLND, and RCHRES operations, 
but these tabs contain a series of check boxes.  With this window the user may turn on or off a section for 
all operations of that type. 
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When the user turns a section on through this editor, other sections might turn on automatically.  This 
section contains some operating rules that understand some sections to be prerequisite to running other 
sections.  These operating rules are based on BASINS Technical Note 3: the NPSM/HSPF Simulation 
Module Matrix.  Following these operating rules, all required and recommended prerequisite sections are 
turned on. 

Then the user may click OK to exit and save the changes or Cancel to exit without saving the changes. 

 

When making sections active, often tables that are not yet present become required by HSPF.  If the user 
has turned some sections on and clicked OK, this editor will give the user the option to automatically add 
the tables required by the active sections. 
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Point Sources 
 

The Point Sources window is accessed either by selecting the Point option from the Functions menu or 

by clicking on the  button on the toolbar.  This window is used to view and manage the point sources 
that may be included in the simulation.  When a new project is created, point source data is written to the 
project WDM file for all point sources and constituents specified in the BASINS point sources file.  All of 
these point source data sets are available through the Point Sources window. 

 

The New frame at the top of the window offers three methods for obtaining new point source data.  
Clicking on the Create button displays the Create Point Source window.  The user types in the 
extension of the Scenario name, selects the Reach from its drop-down list box, either types in or selects 
the Pollutant and Facility from their respective combo boxes, and types in the Daily Load. 
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Once the values have been entered, click the OK button to create the new point source in the project 
WDM file and return to the main Point Sources window.  The Cancel button may be used to return to 
this window without creating a new point source. 

 

Clicking on the Import button displays the Import Point Source window.  Clicking on the Select button 
allows the user to browse for the MUTSIN (*.mut) file to be imported.  MUTSIN files are point source 
data files created by BASINS versions earlier than 3.0.  The user then types in the extension of the 
Scenario name and selects the Reach from its drop-down list box.  The Facility field will automatically 
be filled in with text from the import file. 
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Once the values have been entered, click the OK button to import the new point sources into the project 
WDM file and return to the main Point Sources window.  The Cancel button may be used to return to 
this window without importing a point source. 

 

Clicking on the Convert button scans the HSPF input sequence (the UCI file) and, if this sequence refers 
to any MUTSIN files, all such files are converted to WDM data sets in the project WDM file. 
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The Existing frame at the bottom of the Point Sources window contains a grid displaying the point 
sources in the project WDM file.  The number of point sources displayed in the grid can be restricted by 
making selections from the Scenario, Reach, Pollutant, and Facility drop-down list boxes.  For 
example, if “FLOW” is selected from the Pollutant list box then the grid will display only the point 
sources that have “FLOW” as the Pollutant. 

 

The ‘In Use’ column is used to specify if that point source is in use in the current simulation.  When the 
user sets a point source to ‘In Use’, that point source is added to the External Sources block.  WinHSPF 
will add the appropriate units conversion in the multiplication factor, provided that the daily data in the 
WDM data set is in the standard BASINS units (lbs/day all constituents except flow, which is in cfs) and 
that the time step of the run is in hours.  Thus the multiplication factor for flow will convert cfs to acre-
feet/hour. 

The user may wish to edit values in one of the point source data sets.  This may be done by highlighting a 
field in the row associated with the desired data set then clicking on the List/Edit button.  The following 
form will appear: 
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Values may be edited by clicking on the desired field and entering a new date or value. 

See Lesson 7 of the online tutorial to follow an example of creating, adding, and editing point source data. 

Special Note:  A user may wish to add point source data sets from formats other than the MUTSIN files 
included in BASINS.  This may be accomplished using the program WDMUtil.  When adding a new 
point source data set, be sure to use the units specified above.  In addition, certain conventions should be 
followed in the WDM attribute naming so that WinHSPF Point Sources tool recognizes these data sets as 
candidate point source inputs.  The details of these conventions follow: 

• The scenario id attribute (IDSCEN) must begin with the three characters  “PT-“.  These names will 
appear in the Point Sources ‘Scenario’ list. 

• The constituent id attribute (IDCONS) must consist of a four-character abbreviation for the pollutant, 
or the standard five-digit parameter code.  These names will appear in the Point Sources ‘Pollutant’ 
list. 

• The time series type attribute (TSTYPE) must consist of a four-character abbreviation for the 
pollutant.  If the constituent is flow, this attribute must be “FLOW”. 

• The location id attribute (IDLOCN) must consist of the three characters “RCH” followed by the 
RCHRES id number of the reach on which this point source resides, such as “RCH9” for a point 
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source on RCHRES 9 or “RCH10” for a point source on RCHRES 10.  These names will appear in 
the Point Sources ‘Reach’ list. 

• The station name attribute (STANAM) will appear as the facility name in WinHSPF.  This attribute is 
optional, but the user might wish to add the facility name for consistency. 



 User's Guide 

 81 

Input Data Editor 
 

The Input Data Editor is accessed either by choosing the Edit option from the Functions menu or by 

clicking on the Input Data Editor button on the toolbar.  The Input Data Editor window contains a 
tree diagram of the blocks and tables of HSPF.  The tree diagram is navigated by clicking on an item 
name.  Double-clicking on an item name reveals the subitems within that item, if any exist. 

 

Double-clicking on a block or table name produces another window containing a grid for editing the 
parameters of that block or table. 
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Note that the grid columns may be sorted by clicking on the column heading.  The blocks of HSPF may 
also be accessed for editing using the Edit menu. 

If the user has selected the name of a table that does not yet exist from the tree diagram, a message will 
appear asking if the user would like to add that table.  The input data editor will also automatically add 
tables that become required through the changes made to the HSPF tables. 
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Output Manager 
 

The Output Manager is accessed either by choosing the Functions:Output menu option or by clicking 

the  icon on the toolbar. The Output Manager window will appear containing a set of radio buttons 
and a list of output locations.  The radio buttons are used to specify which of the three types of output to 
view.  Clicking on one of the radio buttons produces a list of locations where that output has been 
specified. 

 

The first output type is Hydrology Calibration.  This button will already be selected when entering the 
Output Manager.  With this button selected, the list below the radio buttons displays the HSPF calibration 
locations within the current HSPF project.  Underneath the radio buttons is a text box explaining which 
output timeseries will be generated during the HSPF model run. 

Adding calibration locations to this list is accomplished by clicking on the Add button. Clicking on this 
button produces another window.  This window contains a list of available calibration locations, i.e. the 
reaches of the watershed, along with two text fields.  The user must choose one of the calibration 
locations, then enter an eight character identifier for that location.  This identifier is used as the location id 
attribute on the WDM time-series data sets that will be created.  The user is also asked to enter a base data 
set number for the data sets to be created.  The new data sets will be numbered as the available data sets 
following that number. 
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Clicking OK from this window brings the user back to the Output Manager window. As the user returns 
to the Output Manager window, eight new time-series data sets are created in the project WDM file, as 
required by the program HSPEXP.  The UCI in memory is modified to include the appropriate Copy 
operation as well as the appropriate External Targets, Schematic, and Mass-Link Blocks. 

 



 User's Guide 

 85 

Clicking the Flow radio button produces a list of locations at which Flow is output.  Flow output can be 
added by means similar to those used to add a calibration location. 

 

The Other radio button is used to view a list of other outputs. 

 



WinHSPF 2.0 

86 

With the Other radio button selected, the Add button may be used to add additional outputs from this 
simulation.  When the Add button is clicked, a window is produced containing a list of model segments. 

 

Choosing one of the model segments causes a list of Group and Members to appear.  This list contains all 
valid Group and Member pairs that can be output from this operation given the current active sections of 
this operation.  When the user chooses one Group/Member pair and then clicks OK, this output 
specification is added. 
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Copy is used to copy output specifications from one model segment to another.  When Copy is clicked, a 
window appears containing a list of operations with output specified. 

 

Choosing one operation from the ‘From’ list and one operation from the ‘To’ list specifies that all output 
specifications from the one operation will be copied to the other. 

 

The Remove button is used to remove an output specification from the list. 

Another option for managing output specifications is by using the Edit:Ext Targets menu option.  
Through the External Targets block editor, the user may add, delete, or modify external targets entries.  In 
adding entries, WinHSPF automatically creates new WDM data sets as specified by the user. 
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Run HSPF 
 

The Run HSPF button on the toolbar is used to perform the HSPF simulation, i.e. run hspf.  Clicking this 
button produces a status window that keeps the user updated as to the state of the run.  This window 
disappears when the run is complete.  The Output button enlarges the window to display a log of all 
messages sent to the status window during the HSPF execution. 
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View Output 
 

The View Output button  on the toolbar is used to start the program GenScn for viewing timeseries 
output.  GenScn is documented seperately. 

Best Management Practices Editor 
 

The Best Management Practices Editor is an advanced feature for assisting users in adding BMPs to a 
simulation.  This feature may be used as an alternative to the method outlined in Lesson 6: Modeling a 
Watershed Management Practice.  The BMP Editor is accessed by choosing the BMP option from the 
Functions menu. 

The BMP window appears with a summary table illustrating the areas of each land use contributing to 
each reach.  This table is provided as a convenience for the user, but areas in this table are not editable. 

 

When a reach is selected from the list at the top of the BMP window, the table changes to show the 
percentage of land area from each land segment under each BMP, as well as the area not under any BMP. 
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If any BMPs exist for this reach, the percentages in this table can be modified by editing the grid.  The 
‘Add’ button adds a BMP for the active reach, and the ‘Delete’ button removes a BMP for the active 
reach.   When any change has been made, the ‘Update UCI’ button becomes available.  Clicking this 
button makes the corresponding change in the UCI in memory.  The change is not actually made in the 
UCI file on disk until the user chooses ‘save’ or ‘save as’ in the main WinHSPF window. 

With a cell selected in a BMP column of the grid (if one has been added), the ‘Edit Removal Efficiency’ 
button may be clicked to edit the removal efficiencies for that BMP. 
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A database of commonly used BMPs is accessable from the BMP Editor for consultation in choosing 
appropriate removal rates.  Clicking a cell of the ‘DB Range’ column produces a reference or other 
comments pertaining to that particular BMP in the text box above the grid. 
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The values of the ‘Fraction’ column may be edited to reflect the removal rates for the BMP.  Once 
complete, the Update UCI button may be clicked to record the changes.  The Close button returns the 
user to the main BMP Editor window. 

Special Note:  The BMP Editor adds connections to the Mass-Link and Schematic Blocks of the UCI file.  
If a Mass-Link already exists containing BMP to RCHRES connections, that Mass-Link will be used for a 
new BMP added through this editor.  If such a Mass-Link does not exist, WinHSPF will automatically 
build that Mass-Link, pulling default values from the PERLND/IMPLND to RCHRES Mass-Link.  When 
using the BMP Editor, care should be taken to make sure that the Mass-Link connections used by default 
are appropriate for the current simulation. 
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Appendix 
BASINS File Samples 
 

This section provides examples of the files from BASINS used to create a new project in WinHSPF.  
These files are intended to be produced using the BASINS GIS interface, but since they are text files, they 
may be built manually using a text editor.  For complete descriptions of the contents of these files, see 
BASINS Files within the System Overview section. 

• Watershed File - *.wsd 

• Reach File - *.rch 

• Channel Geometry File - *.ptf 

• Point Sources File - *.psr 

Watershed File Sample 
 
The following is an example of the Watershed File.  Definitions of the fields in the Watershed File are 
found in the Watershed File section of the User’s Guide. 
“LU Name”,”Type (1=Impervious, 2=Pervious)”,”Watershd-
ID”,”Area”,”Slope”,”Distance” 
“Forest Land”  2       1        27228  0.045574  8781.03 
“Agricultural Land”  2       1        13675  0.045574  8781.03 
“Urban or Built-up Land”  2       1        115  0.045574  8781.03 
“Urban or Built-up Land”  1       1        115  0.045574  8781.03 
“Barren Land”  2       1        623  0.045574  8781.03 
“Water”  2       1        58  0.045574  8781.03 
“Forest Land”  2       2        23472  0.062112  8023.88 
“Agricultural Land”  2       2        3104  0.062112  8023.88 
“Water”  2       2        62  0.062112  8023.88 
“Urban or Built-up Land”  2       2        759  0.062112  8023.88 
“Urban or Built-up Land”  1       2        759  0.062112  8023.88 
“Barren Land”  2       2        279  0.062112  8023.88 
“Forest Land”  2       3        16478  0.085153  5861.96 
“Agricultural Land”  2       3        4118  0.085153  5861.96 
“Barren Land”  2       3        327  0.085153  5861.96 
“Urban or Built-up Land”  2       3        71  0.085153  5861.96 
“Urban or Built-up Land”  1       3        71  0.085153  5861.96 

Reach File Sample 
 

The following is an example of the Reach File.  Definitions of the fields in the Reach File are found in the 
Reach File section of the User’s Guide. 
“Rivrch”,”Pname”,”Watershed-ID”,”HeadwaterFlag”,”Exits”,”Milept”,”Stream/Resevoir 
Type”,”Segl”,”Delth”,”Elev”,”Ulcsm”,”Urcsm”,”Dscsm”,”Ccsm”,”Mnflow”,”Mnvelo”,”Svtnflow”,”Svtnvelo
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”,”Pslope”,”Pdepth”,”Pwidth”,”Pmile”,”Ptemp”,”Pph”,”Pk1”,”Pk2”,”Pk3”,”Pmann”,”Psod”,”Pbgdo”,”Pbgn
h3”,”Pbgbod5”,”Pbgbod”,Level 
1 “STREAM 1” 1 1 1 0 S 15.36 350.96 1573 -9999 -9999 3 2 0 0 0 0 0.012356 3.32133 91.9856 0 0 0 0 
0 0 0 0 0 0 0 0 0 
2 “STREAM 2” 2 1 1 0 S 11.82 596.96 1696 -9999 -9999 3 1 0 0 0 0 0.009563 2.84606 72.9574 0 0 0 0 
0 0 0 0 0 0 0 0 0 
3 “STREAM 3” 3 0 1 0 S 9.27 101.68 1350 1 2 -9999 -9999 0 0 0 0 0.002077 4.53886 146.945 0 0 0 0 
0 0 0 0 0 0 0 0 0 

Channel Geometry File Sample 
 

The following is an example of the Channel Geometry File.  Definitions of the fields in the Channel 
Geometry File are found in the Channel Geometry File section of the User’s Guide. 
“Reach Number”,”Length(ft)”,”Mean Depth(ft)”,”Mean Width (ft)”,”Mannings Roughness Coeff.”,”Long. 
Slope”,”Type of x-section”,”Side slope of upper FP left”,”Side slope of lower FP left”,”Zero 
slope FP width left(ft)”,”Side slope of channel left”,”Side slope of channel right”,”Zero slope 
FP width right(ft)”,”Side slope lower FP right”,”Side slope upper FP right”,”Channel 
Depth(ft)”,”Flood side slope change at depth”,”Max. depth”,”No. of exits”,”Fraction of flow 
through exit 1”,”Fraction of flow through exit 2”,”Fraction of flow through exit 3”,”Fraction of 
flow through exit 4”,”Fraction of flow through exit 5” 
1 81095 3.32133 91.98563 0.05 0.01236 Trapezoidal 0.5 0.5 91.9856 1 1 91.9856 0.5 0.5 4.15166 
6.22749 207.583 1 1 0 0 0 0 
2 62424 2.84606 72.95737 0.05 0.00956 Trapezoidal 0.5 0.5 72.9574 1 1 72.9574 0.5 0.5 3.55757 
5.33636 177.879 1 1 0 0 0 0 
3 48949 4.53886 146.94531 0.05 0.00208 Trapezoidal 0.5 0.5 146.945 1 1 146.945 0.5 0.5 5.67358 
8.51037 283.679 1 1 0 0 0 0 

Point Sources File Sample 
 

The following is an example of the Point Sources File.  Definitions of the fields in the Point Sources File 
are found in the Point Sources File section of the User’s Guide. 
3 
 
“Facility Name” “Npdes” “Cuseg” “Mi” 
“PORTAGE AREA SEW AUTH” PA0032611 8 2.48 
“GPU/GENCO-HOMER CITY GENERATING STATION” PA0005037 11 0.35 
“SPECIALTY TIRES OF AMERICA” PA0004057 5 9.92 
 
“Ordinal Number” “Pollutant” “Load (lbs/hr)” 
0 “SOLIDS, TOTAL SUSPENDED” 10802.539600 
0 “CHLORINE, TOTAL RESIDUAL” 93.583019 
0 “BOD, CARBONACEOUS 05 DAY, 20C” 68728.332200 
0 “CBODU (20 deg C), calculated” 46966.193090 
1 “OXYGEN, DISSOLVED (DO)” 4947.152820 
1 “SOLIDS, TOTAL SUSPENDED” 314407.965953 
1 “OIL AND GREASE FREON EXTR-GRAV METH” 37838.656042 
1 “ARSENIC, TOTAL (AS AS)” 288.154903 
1 “CADMIUM, TOTAL (AS CD)” 9.639183 
1 “IRON, DISSOLVED (AS FE)” 114.001343 
1 “MANGANESE, TOTAL (AS MN)” 499.115311 
1 “THALLIUM, TOTAL (AS TL)” 2.264882 
1 “ALUMINUM, TOTAL (AS AL)” 84.361993 
1 “CHLORINE, TOTAL RESIDUAL” 1695.200409 
1 “BOD, CARBONACEOUS 05 DAY, 20C” 3015.365281 
1 “CBODU (20 deg C), calculated” 2060.580020 
2 “OIL AND GREASE FREON EXTR-GRAV METH” 3384.743450 
0 Flow 0.0438100 
1 Flow 0.0000000 
2 Flow 0.0000000 


